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Chapter 411

Wilcoxon SignedRank Tests
Introduction
The one-sample t-test is used to test whether the mean of a population is greater than, less than, or not equal to a
specific value. Because the t distribution is used to calculate critical values for the test, this test is often called the
one-sample t-test. The t-test assumes that the population standard deviation is unknown and will be estimated by the
data.
The nonparametric analog of the t-test is the Wilcoxon Signed-Rank Test and may be used when the one-sample ttest assumptions are violated.

Other PASS Procedures for Testing One Mean or Median
Procedures in PASS are primarily built upon the testing methods, test statistic, and test assumptions that will be
used when the analysis of the data is performed. You should check to identify that the test procedure described
below in the Test Procedure section matches your intended procedure. If your assumptions or testing method are
different, you may wish to use one of the other one-sample procedures available in PASS–the One-Sample ZTests and the One-Sample T-Tests procedures. The methods, statistics, and assumptions for those procedures are
described in the associated chapters.
If you wish to show that the mean of a population is larger (or smaller) than a reference value by a specified
amount, you should use one of the clinical superiority procedures for comparing means. Non-inferiority,
equivalence, and confidence interval procedures are also available.

Assumptions for One-Sample Tests
This section describes the assumptions that are made when you use one of the one-sample tests. The key
assumption relates to normality or non-normality of the data. One of the reasons for the popularity of the t-test is
its robustness in the face of assumption violation. However, if an assumption is not met even approximately, the
significance levels and the power of the t-test are invalidated. Unfortunately, in practice it often happens that
several assumptions are not met. This makes matters even worse! Hence, take the steps to check the assumptions
before you make important decisions based on these tests.

411-1
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Wilcoxon Signed-Rank Tests

One-Sample Z-Test Assumptions
The assumptions of the one-sample z-test are:
1. The data are continuous (not discrete).
2. The data follow the normal probability distribution.
3. The sample is a simple random sample from its population. Each individual in the population has an equal
probability of being selected in the sample.
4. The population standard deviation is known.

One-Sample T-Test Assumptions
The assumptions of the one-sample t-test are:
1. The data are continuous (not discrete).
2. The data follow the normal probability distribution.
3. The sample is a simple random sample from its population. Each individual in the population has an equal
probability of being selected in the sample.

Paired T-Test Assumptions
The assumptions of the paired t-test are:
1. The data are continuous (not discrete).
2. The data, i.e., the differences for the matched-pairs, follow a normal probability distribution.
3. The sample of pairs is a simple random sample from its population. Each individual in the population has
an equal probability of being selected in the sample.

Wilcoxon Signed-Rank Test Assumptions
The assumptions of the Wilcoxon signed-rank test are as follows (note that the difference is between a data value
and the hypothesized median or between the two data values of a pair):
1. The differences are continuous (not discrete).
2. The distribution of each difference is symmetric.
3. The differences are mutually independent.
4. The differences all have the same median.
5. The measurement scale is at least interval.

Limitations
There are few limitations when using these tests. Sample sizes may range from a few to several hundred. If your
data are discrete with at least five unique values, you can often ignore the continuous variable assumption.
Perhaps the greatest restriction is that your data come from a random sample of the population. If you do not have
a random sample, your significance levels will probably be incorrect.
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Wilcoxon Signed-Rank Test Statistic
The Wilcoxon signed-rank test is a popular, nonparametric substitute for the t-test. It assumes that the data follow
a symmetric distribution. The test is computed using the following steps.
1. Subtract the hypothesized mean, 𝜇𝜇0 , from each data value. Rank the values according to their absolute
values.

2. Compute the sum of the positive ranks Sp and the sum of the negative ranks Sn. The test statistic, 𝑊𝑊𝑅𝑅 , is
the minimum of Sp and Sn.
3. Compute the mean and standard deviation of 𝑊𝑊𝑅𝑅 using the formulas
𝜇𝜇𝑊𝑊𝑅𝑅 =

𝑛𝑛(𝑛𝑛 + 1)
4

𝑛𝑛(𝑛𝑛 + 1)(2𝑛𝑛 + 1) ∑ 𝑡𝑡 3 − ∑ 𝑡𝑡
−
𝜎𝜎𝑊𝑊𝑅𝑅 = �
24
48

where t represents the number of times the ith value occurs.
4. Compute the z-value using
𝑧𝑧𝑊𝑊 =

𝑊𝑊𝑅𝑅 − 𝜇𝜇𝑊𝑊𝑅𝑅
𝜎𝜎𝑊𝑊𝑅𝑅

The significance of the test statistic is determined by computing the p-value using the standard normal
distribution. If this p-value is less than a specified level (usually 0.05), the null hypothesis is rejected in favor of
the alternative hypothesis. Otherwise, no conclusion can be reached.

Power Calculation for the Wilcoxon Signed-Rank Test
The power calculation for the Wilcoxon signed-rank test is the same as that for the one-sample t-test except that
an adjustment is made to the sample size based on an assumed data distribution as described in Al-Sunduqchi and
Guenther (1990). The sample size 𝑛𝑛′ used in power calculations is equal to
𝑛𝑛′ = 𝑛𝑛⁄𝑊𝑊 ,

where 𝑊𝑊 is the Wilcoxon adjustment factor based on the assumed data distribution.

The adjustments are as follows:
Distribution

W

Uniform

1

Double Exponential

2⁄3

Logistic
Normal

9⁄𝜋𝜋 2

𝜋𝜋⁄3

The power is calculated as follows for a directional alternative (one-tailed test) in which 𝜇𝜇1 > 𝜇𝜇0 .

1. Find 𝑡𝑡𝛼𝛼 such that 1 − 𝑇𝑇𝑑𝑑𝑑𝑑 (𝑡𝑡𝛼𝛼 ) = 𝛼𝛼, where 𝑇𝑇𝑑𝑑𝑑𝑑 (𝑡𝑡𝛼𝛼 ) is the area under a central-t curve to the left of x and
df = 𝑛𝑛′ – 1.

2. Calculate: 𝑋𝑋1 = 𝜇𝜇0 + 𝑡𝑡𝛼𝛼

𝜎𝜎

√𝑛𝑛′

.
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3. Calculate the noncentrality parameter: 𝜆𝜆 =

4. Calculate: 𝑡𝑡1 =

𝑋𝑋1 −𝜇𝜇1
𝜎𝜎

�𝑛𝑛′

+ 𝜆𝜆.

𝜇𝜇1 −𝜇𝜇0
𝜎𝜎

�𝑛𝑛′

=

𝛿𝛿1
𝜎𝜎

.

�𝑛𝑛′

′
′
(𝑡𝑡1 ), where 𝑇𝑇𝑑𝑑𝑑𝑑,𝜆𝜆
(𝑥𝑥) is the area to the left of x under a noncentral-t curve with degrees
5. Power = 1 − 𝑇𝑇𝑑𝑑𝑑𝑑,𝜆𝜆
of freedom df and noncentrality parameter 𝜆𝜆.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be calculated from the values of the other parameters. Under most
conditions, you would select either Power or Sample Size.
Select Sample Size when you want to determine the sample size needed to achieve a given power and alpha error
level.
Select Power when you want to calculate the power of an experiment that has already been run.

Test
Alternative Hypothesis
Specify the alternative hypothesis of the test. Since the null hypothesis is the opposite of the alternative,
specifying the alternative is all that is needed. Usually, the two-tailed (≠) option is selected.
The options containing only < or > are one-tailed tests. When you choose one of these options, you must be sure
that the input parameters match this selection.
Possible selections are:
•

Two-Sided (H1: μ ≠ μ0)
This is the most common selection. It yields the two-tailed t-test. Use this option when you are testing
whether the means are different but you do not want to specify beforehand which mean is larger. Many
scientific journals require two-tailed tests.

•

One-Sided (H1: μ < μ0)
This option yields a one-tailed t-test. Use it when you are only interested in the case in which μ is less than
μ0.

•

One-Sided (H1: μ > μ0)
This option yields a one-tailed t-test. Use it when you are only interested in the case in which μ is greater than
μ0.
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Data Distribution
This option makes appropriate sample size adjustments for the Wilcoxon Signed-Rank test. Results by AlSunduqchi and Guenther (1990) indicate that power calculations for the Wilcoxon Signed-Rank test may be made
using the standard t-test formulations with a simple adjustment to the sample size. The size of the adjustment
depends upon the actual distribution of the data. They give sample size adjustment factors for four distributions.
The options are as follows:
•

Uniform
The sample size adjustment factor, W, is equal to “1”. This selection gives the same result as the one-sample
t-test.

•

Double Exponential
The sample size adjustment factor, W, is equal to “2/3”.

•

Logistic
The sample size adjustment factor, W, is equal to “9/π²”.

•

Normal
The sample size adjustment factor, W, is equal to “π/3”.

Population Size
This is the number of subjects in the population. Usually, you assume that samples are drawn from a very large
(infinite) population. Occasionally, however, situations arise in which the population of interest is of limited size.
In these cases, appropriate adjustments must be made.
When a finite population size is specified, the standard deviation is reduced according to the formula:
𝑛𝑛
𝜎𝜎12 = �1 − � 𝜎𝜎 2
𝑁𝑁
where n is the sample size, N is the population size, 𝜎𝜎 is the original standard deviation, and 𝜎𝜎1 is the new
standard deviation.
𝑛𝑛

The quantity n/N is often called the sampling fraction. The quantity �1 − � is called the finite population
𝑁𝑁
correction factor.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
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Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Sample Size)
This option specifies one or more values of the sample size, the number of individuals in the study. This value
must be an integer greater than one. Note that you may enter a list of values using the syntax 50,100,150,200,250
or 50 to 250 by 50.

Effect Size – Means
μ0 (Null or Baseline Mean)
Enter a value for the population mean under the null hypothesis. This is the reference or baseline mean. If you are
analyzing a paired t-test, this value should be zero.
Only the difference between μ1 and μ0 is used in the calculations.
μ1 (Actual Mean)
Enter a value (or range of values) for the actual population mean at which power and sample size are calculated.
Only the difference between μ1 and μ0 is used in the calculations.

Effect Size – Standard Deviation
σ (Standard Deviation)
This option specifies one or more values of the standard deviation. This must be a positive value. Be sure to use
the standard deviation of X and not the standard deviation of the mean (the standard error). If you are doing a
paired test, this is the standard deviation of the differences.
When this value is not known, you must supply an estimate of it. PASS includes a special module for estimating
the standard deviation. This module may be loaded by pressing the SD button. Refer to the Standard Deviation
Estimator chapter for further details.
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Example 1 – Power after a Study
This example will cover the situation in which you are calculating the power of a Wilcoxon Signed-Rank test on
data that have already been collected and analyzed. For example, you might be playing the role of a reviewer,
looking at the power of a Wilcoxon Signed-Rank test from a study you are reviewing. In this case, you would not
vary the means, standard deviation, or sample size since they are given by the experiment. Instead, you investigate
the power of the significance tests. You might look at the impact of different alpha values on the power.
Suppose an experiment involving 100 individuals yields the following summary statistics:
Hypothesized mean (μ0)
Sample mean (μ1)
Sample standard deviation
Sample size

100.0
110.0
40.0
100

Given the above data, analyze the power of a Wilcoxon Signed-Rank test which tests the hypothesis that the
population median is 100 versus the alternative hypothesis that the population median is 110. Consider the power
at significance levels 0.01, 0.05, 0.10 and sample sizes 20 to 120 by 20 when the assumed data distribution is
Logistic.
Note that we have set μ1 equal to the sample mean. In this case, we are studying the power of the Wilcoxon
Signed-Rank test for a mean difference the size of that found in the experimental data.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Wilcoxon Signed-Rank Tests procedure window by expanding Means, then One Mean, then
clicking on Nonparametric, and then clicking on Wilcoxon Signed-Rank Tests. You may then make the
appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example
Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ Two-Sided (H1: μ ≠ μ0)
Data Distribution ..................................... Logistic
Population Size ....................................... Infinite
Alpha ....................................................... 0.01 0.05 0.10
N (Sample Size)...................................... 20 to 120 by 20
μ0 (Null or Baseline Mean) ..................... 100
μ1 (Actual mean) .................................... 110
σ (Standard Deviation) ........................... 40

411-7
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Wilcoxon Signed-Rank Tests

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: μ = μ0 vs. H1: μ ≠ μ0
Data Distribution: Logistic

Power
N
0.06416
20
0.15855
40
0.27019
60
0.38634
80
0.49768 100
0.59833 120
(report continues)

μ0
100.0
100.0
100.0
100.0
100.0
100.0

μ1
110.0
110.0
110.0
110.0
110.0
110.0

Diff
μ1 - μ0
10.0
10.0
10.0
10.0
10.0
10.0

σ
40.0
40.0
40.0
40.0
40.0
40.0

Effect
Size
0.250
0.250
0.250
0.250
0.250
0.250

Alpha
0.010
0.010
0.010
0.010
0.010
0.010

Beta
0.93584
0.84145
0.72981
0.61366
0.50232
0.40167

Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
N is the size of the sample drawn from the population. To conserve resources, it should be small.
μ0 is the value of the population mean under the null hypothesis.
μ1 is the actual value of the population mean at which power and sample size are calculated.
μ1 - μ0 is the difference between the actual and null means.
σ is the standard deviation of the population. It measures the variability in the population.
Effect Size = |μ1 - μ0|/σ is the relative magnitude of the effect.
Alpha is the probability of rejecting a true null hypothesis. It should be small.
Beta is the probability of accepting a false null hypothesis. It should be small.
Summary Statements ─────────────────────────────────────────────────────────
A sample size of 20 achieves 6% power to detect a difference of 10.0 between the actual mean of
110.0 and the null hypothesized mean of 100.0 with an estimated standard deviation of 40.0 and
with a significance level (alpha) of 0.010 using a two-sided Wilcoxon Signed-Rank test assuming
that the actual data distribution is logistic.

This report shows the values of each of the parameters, one scenario per row. The values of power and beta were
calculated from the other parameters.
The definitions of each column are given in the Report Definitions section.

Plots Section

These plots show the relationship between sample size and power for various values of alpha.
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Example 2 – Finding the Sample Size
This example will consider the situation in which you are planning a study that will use the Wilcoxon SignedRank test and want to determine an appropriate sample size. This example is more subjective than the first
because you now have to obtain estimates of all the parameters. In the first example, these estimates were
provided by the data.
In studying deaths from SIDS (Sudden Infant Death Syndrome), one hypothesis put forward is that infants dying
of SIDS weigh less than normal at birth. Suppose the average birth weight of infants is 3300 grams with a
standard deviation of 663 grams. Use an alpha of 0.05 and power of both 0.80 and 0.90. How large a sample of
SIDS infants will be needed to detect a drop in average weight of 25%? Of 10%? Of 5%? Note that applying these
percentages to the average weight of 3300 yields 2475, 2970, and 3135.
Although a one-sided hypothesis is being considered, sample size estimates will assume a two-sided alternative to
keep the research design in line with other studies. The assumed data distribution will be normal.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Wilcoxon Signed-Rank Tests procedure window by expanding Means, then One Mean, then
clicking on Nonparametric, and then clicking on Wilcoxon Signed-Rank Tests. You may then make the
appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example
Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Two-Sided (H1: μ ≠ μ0)
Data Distribution ..................................... Normal
Population Size ....................................... Infinite
Power ...................................................... 0.80 0.90
Alpha ....................................................... 0.05
μ0 (Null or Baseline Mean) ..................... 3300
μ1 (Actual mean) .................................... 2475 2970 3135
σ (Standard Deviation) ........................... 663

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: μ = μ0 vs. H1: μ ≠ μ0
Data Distribution: Normal

Power
0.85339
0.90307
0.80426
0.90409
0.80105
0.90070

N
9
10
36
48
136
181

μ0
3300.0
3300.0
3300.0
3300.0
3300.0
3300.0

μ1
2475.0
2475.0
2970.0
2970.0
3135.0
3135.0

Diff
μ1 - μ0
-825.0
-825.0
-330.0
-330.0
-165.0
-165.0

σ
663.0
663.0
663.0
663.0
663.0
663.0

Effect
Size
1.244
1.244
0.498
0.498
0.249
0.249

Alpha
0.050
0.050
0.050
0.050
0.050
0.050

Beta
0.14661
0.09693
0.19574
0.09591
0.19895
0.09930

This report shows the values of each of the parameters, one scenario per row. Since there were three values of μ1
and two values of power, there are a total of six rows in the report.
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We were solving for the sample size, N. Notice that the increase in sample size seems to be most directly related
to the difference between the two means. The difference in beta values does not seem to be as influential,
especially at the smaller sample sizes.
Note that even though we set the power values at 0.8 and 0.9, these are not the power values that were achieved.
This happens because N can only take on integer values. The program selects the first value of N that gives at
least the values of alpha and power that were desired.

Example 3 – Finding the Minimum Detectable Difference
This example will consider the situation in which you want to determine how small of a difference between the
two means can be detected by the Wilcoxon Signed-Rank test with specified values of the other parameters.
Continuing with the previous example, suppose about 50 SIDS deaths occur in a particular area per year. Using
50 as the sample size, 0.05 as alpha, and 0.80 as power, how large of a difference between the means is
detectable?

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Wilcoxon Signed-Rank Tests procedure window by expanding Means, then One Mean, then
clicking on Nonparametric, and then clicking on Wilcoxon Signed-Rank Tests. You may then make the
appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example
Template.
Option

Value

Design Tab
Solve For ................................................ μ1 (Search < μ0)
Alternative Hypothesis ............................ Two-Sided (H1: μ ≠ μ0)
Data Distribution ..................................... Normal
Population Size ....................................... Infinite
Power ...................................................... 0.80
Alpha ....................................................... 0.05
N (Sample Size)...................................... 50
μ0 (Null or Baseline Mean) ..................... 3300
σ (Standard Deviation) ........................... 663

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: μ = μ0 vs. H1: μ ≠ μ0
Data Distribution: Normal

Power
0.80000

N
50

μ0
3300.0

μ1
3023.2

Diff
μ1 - μ0
-276.8

σ
663.0

Effect
Size
0.417

Alpha
0.050

Beta
0.20000

With a sample of 50, a difference of 3023.2 - 3300 = -276.8 would be detectable.
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Example 4 – Validation using Chow, Shao, Wang, and Lokhnygina
(2018)
Chow, Shao, Wang, and Lokhnygina (2018) presents an example on pages 45 and 46 of a two-sided one-sample ttest sample size calculation in which μ0 = 1.5, μ1 = 2.0, σ = 1.0, alpha = 0.05, and power = 0.80. They obtain a
sample size of 34.
The Wilcoxon Signed-Rank test power calculations are the same as the one-sample t-test except for an adjustment
factor for the assumed data distribution. If we assume a uniform data distribution, we should get this same result.
If we set the data distribution to Normal, we should get a result of N = 34 × π/3 = 35.605 = 36.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Wilcoxon Signed-Rank Tests procedure window by expanding Means, then One Mean, then
clicking on Nonparametric, and then clicking on Wilcoxon Signed-Rank Tests. You may then make the
appropriate entries as listed below, or open Example 4 (a or b) by going to the File menu and choosing Open
Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Two-Sided (H1: μ ≠ μ0)
Data Distribution ..................................... Uniform
Population Size ....................................... Infinite
Power ...................................................... 0.80
Alpha ....................................................... 0.05
μ0 (Null or Baseline Mean) ..................... 1.5
μ1 (Actual Mean) .................................... 2
σ (Standard Deviation) ........................... 1

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: μ = μ0 vs. H1: μ ≠ μ0
Data Distribution: Uniform

Power
0.80778

N
34

μ0
1.5

μ1
2.0

Diff
μ1 - μ0
0.5

σ
1.0

Effect
Size
0.500

Alpha
0.050

Beta
0.19222

The sample size of 34 matches Chow, Shao, Wang, and Lokhnygina (2018) exactly. If we now assume a Normal
data distribution, the results match our expected outcome.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: μ = μ0 vs. H1: μ ≠ μ0
Data Distribution: Normal

Power
0.80778

N
36

μ0
1.5

μ1
2.0

Diff
μ1 - μ0
0.5

σ
1.0

Effect
Size
0.500

Alpha
0.050

Beta
0.19222

The sample size of 36 matches the expected result.
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Example 5 – Validation using Zar (1984)
Zar (1984) pages 111-112 presents an example in which μ0 = 0.0, μ1 = 1.0, σ = 1.25, alpha = 0.05, and N = 12.
Zar obtains an approximate power of 0.72 for the one sample t-test.
The Wilcoxon Signed-Rank test power calculations are the same as the one-sample t-test except for an adjustment
factor for the assumed data distribution. If we assume a uniform data distribution, we should get the same power
with N = 12. If we assume a Double Exponential data distribution with N = 12 × 2/3 = 8, then the adjusted sample
size would be N’ = 8/(2/3) = 12 and we should get the same power as Zar (1984).

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Wilcoxon Signed-Rank Tests procedure window by expanding Means, then One Mean, then
clicking on Nonparametric, and then clicking on Wilcoxon Signed-Rank Tests. You may then make the
appropriate entries as listed below, or open Example 5 (a or b) by going to the File menu and choosing Open
Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ Two-Sided (H1: μ ≠ μ0)
Data Distribution ..................................... Uniform
Population Size ....................................... Infinite
Alpha ....................................................... 0.05
N (Sample Size)...................................... 12
μ0 (Null or Baseline Mean) ..................... 0
μ1 (Actual Mean) .................................... 1
σ (Standard Deviation) ........................... 1.25

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: μ = μ0 vs. H1: μ ≠ μ0
Data Distribution: Uniform

Power
0.71366

N
12

μ0
0.0

μ1
1.0

Diff
μ1 - μ0
1.0

σ
1.25

Effect
Size
0.800

Alpha
0.050

Beta
0.28634

The difference between the power computed by PASS of 0.71366 and the 0.72 computed by Zar is due to Zar’s
use of an approximation to the noncentral t distribution. Notice that the results for the Wilcoxon signed-rank test
with the uniform distribution match the one-sample t-test results.
If we now assume a double exponential data distribution and set N = 8, the results match our expected outcome.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: μ = μ0 vs. H1: μ ≠ μ0
Data Distribution: Double Exponential

Power
0.71366

N
8

μ0
0.0

μ1
1.0

Diff
μ1 - μ0
1.0

σ
1.25

Effect
Size
0.800

Alpha
0.050

Beta
0.28634

The power of 0.71366 matches the expected result.
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Example 6 – Validation using Machin (1997)
Machin, Campbell, Fayers, and Pinol (1997) page 37 presents an example in which μ0 = 0.0, μ1 = 0.2, σ = 1.0,
alpha = 0.05, and beta = 0.20. They obtain a sample size of 199.
As in Example 4, if we set the data distribution to Uniform, we should get this same result. If we set the data
distribution to double exponential, we should get a result of N = 199 × 2/3 = 132.6667 = 133.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Wilcoxon Signed-Rank Tests procedure window by expanding Means, then One Mean, then
clicking on Nonparametric, and then clicking on Wilcoxon Signed-Rank Tests. You may then make the
appropriate entries as listed below, or open Example 6 (a or b) by going to the File menu and choosing Open
Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Two-Sided (H1: μ ≠ μ0)
Data Distribution ..................................... Uniform
Population Size ....................................... Infinite
Power ...................................................... 0.80
Alpha ....................................................... 0.05
μ0 (Null or Baseline Mean) ..................... 0
μ1 (Actual mean) .................................... 0.2
σ (Standard Deviation) ........................... 1

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: μ = μ0 vs. H1: μ ≠ μ0
Data Distribution: Uniform

Power
0.80169

N
199

μ0
0.0

μ1
0.2

Diff
μ1 - μ0
0.2

σ
1.0

Effect
Size
0.200

Alpha
0.050

Beta
0.19831

The sample size of 199 matches Machin’s result. If we now assume a double exponential data distribution, the
results match our expected outcome.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: μ = μ0 vs. H1: μ ≠ μ0
Data Distribution: Double Exponential

Power
0.80169

N
133

μ0
0.0

μ1
0.2

Diff
μ1 - μ0
0.2

σ
1.0

Effect
Size
0.200

Alpha
0.050

Beta
0.19831

The sample size of 133 matches the expected result.
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